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About This Manual

This manual, as well as the software described in it, is furnished under license and may only be used or copied
in accordance with the terms of such license. The information in this manual is furnished for informational use
only, is subject to change without notice, and should not be construed as a commitment by Sonic Studio, LLC.
Sonic Studio, LLC assumes no responsibility or liability for any errors or inaccuracies that may appear in this
book.

Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval
system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without
the prior written permission of Sonic Studio, LLC.

Notice of Liability

The author and publisher have made every effort to ensure the accuracy of the information herein. However,
the information contained in this document is provided without warranty, either express or implied. Neither
the authors, Sonic Studio, LLC, nor its dealers or distributors will be held liable for any damages to be caused
either directly or indirectly by the instructions contained in this book, or by the software or hardware products
described herein.

SONIC STUDIO, LLC MAKES NO WARRANTIES, EXPRESS OR IMPLIED, INCLUDING
WITHOUT LIMITATION THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE, REGARDING THE APPLE SOFTWARE.
SONIC STUDIO, LLC DOES NOT WARRANT, GUARANTEE, OR MAKE ANY
REPRESENTATIONS REGARDING THE USE ORTHE RESULTS OF THE USE OF THE
SONIC STUDIO, LLC SOFTWARE INTERMS OF ITS CORRECTNESS,ACCURACY,
RELIABILITY, CURRENTNESS, OR OTHERWISE.THE ENTIRE RISK ASTO THE
RESULTS AND PERFORMANCE OF THE SONIC STUDIO SOFTWARE IS ASSUMED
BYYOU.THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME
STATES.THE ABOVE EXCLUSION MAY NOT APPLY TOYOU.

IN NO EVENT WILL SONIC STUDIO, LLC,ITS DIRECTORS, OFFICERS, EMPLOYEES,
ORAGENTS BE LIABLETOYOU FORANY CONSEQUENTIAL, INCIDENTAL, OR
INDIRECT DAMAGES (INCLUDING DAMAGES FOR LOSS OF BUSINESS PROFITS,
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION,AND THE LIKE)
ARISING OUT OF THE USE OR INABILITY TO USE THE SONIC STUDIO SOFTWARE
EVEN IF SONIC STUDIO HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, THE
ABOVE LIMITATIONS MAY NOT APPLY TOYOU.

Notice of Rights

©2007-201 I Sonic Studio, LLC — All rights reserved. No part of this document may be reproduced, stored
in a retrieval system or transmitted in any form or by any means, without the prior written permission of the
publisher.

Sonic Studio, Amarra, Amarra, Amarra Junior, SSE, NoNOISE native, Sonic EQ, Model 302, Model 303, Model
Four, Model 305 and the Sonic Studio and Amarra logos are trademarks of Sonic Studio, LLC. All other
company or product names are either trademarks or registered trademarks of their respective owners.

Page #3



Amarra Computer Music Player User Manual

1.0.0 Thank you!

Thank you for purchasing the Amarra Computer Music Player. You are about to enjoy the Ultrafidelity sound of
Amarra. Designed to work with your Apple™ Macintosh Computer and with iTunes, Amarra provides a seamless
integration for high resolution music playback.

The Amarra Team

Sonic Studio, LLC

330 Sir Frances Drake Blvd, Suite A San Anselmo, CA USA 94960-2552
phone: 1-919-426-2772

support@sonicstudio.com

www.amarraaudio.com

This document details the installation of Amarra and its associated software.
The Amarra 2.3 installer will install the following items on to your Macintosh Computer:

* Amarra 2.3 Computer Music Player
* Amarra Documentation
* FLAC Component

2.0.0 Amarramum System Requirements:

Computer:
* Any Intel-based Mac
* RAM: 3 GB memory, 4 or more preferred (8 GB recommended for best CACHE Playback)
* For best results a high performance USB/FireWire audio interface
* Software:
* Mac OS X 10.5, 10.6 and above recommended
* Amarra software
* iTunes

Supported Audio Hardware Interfaces:
* Most Core Audio Interface will work with Amarra. This includes USB, FireWire, and optical
connections on the Macintosh. Please visit the Hardware section of www.amarraaudio.com for more

information.

Peripheral FireWire Adaptors supported:
* OHCI compliant PCCard, PCl card, ExpressCard or PCle card

We recommend a fresh install of the operating system on a clean disc.This can prevent problems later on.

We also highly recommend that your computer be used exclusively for music playback. Email, web browsers, screen
sharing and other applications can all affect performance.

3.0.0 Installing Amarra Software:

To install Amarra, insert the install disk in your computer or locate the download of Amarra, then click on the
Amarra_lInstaller icon. Follow the on screen instructions to install your software.
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Welcome screen for Amarra Installer:

O00 & Install Amarra 2.3 Music Player

Welcome to the Amarra 2.3 Music Player Installer

@ Introduction Amarra 2.3 (Build 4296) August. 2011 0

@ License
Please Read Before You Begin...
® Destination Select
Thank youl
® Installation Type o . " . 3 .
This file contains important information about the installation and
® Installation operation of your application. A more complete version of this
document is available in the application's folder.

® Summary

Changes since 2.2.3 ::

@ New User Interface

@ Fixes for metadata in FLAC files
= Fixes for Orpheus Device

@ Fixes for RME Babyface

= Support for QuickTime Movies

.

Changes since 2.2 ::

Select Continue.

Software License Agreement:

00 & Install Amarra 2.3 Music Player

Software License Agreement

[ English H
& Introduction ’
Sonic Studio, LLC End User License Agreement
O License 0
@ Destination Select Please read this carefully. This Agreement is a contract between
; you, either an individual or single entity, and Sonic Studio, LLC. Your
@ Installation Type installation and use of the accompanying software indicates your
agreement to be bound by the terms and conditions of this

® Installation Agreement.

® Summary
The sofiware products, associated media, printed materials and
electronic documentation accompanying this license (collectively,
"Software”) is owned by Sonic Studio, LLC. This Sofiware is not sold,
but may be used only by persons or entities that have been granted a
License to use the program ("Licensee”). Such grant of License is
conditional upon payment of applicable license fees and agreement
to the License terms stated herein.

In consideration for your payment of the applicable license fees,
Sonic Studio, LLC grants you the following rights:

ar(

Cprine ) (Save

Select Continue.
Agree to the Software License Agreement

Please Read Carefully. Select Continue.
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aRA £ Install Amarra 2.3 Music Player
To continue installing the software you must agree to the terms
of the software license agreement.
O Int
@ Lic Click Agree to continue or click Disagree to cancel the installation
and quit the Installer.
® De n
:
® Ins| . - r
(Oisagres ) (Agree )
® Ins|
® Summary

The software products, associated media, printed materials and
electronic documentation accompanying this license (collectively,
"Software”) is owned by Sonic Studio, LLC. This Software is not sold,
but may be used only by persons or entities that have been granted a
License to use the program ("Licensee”). Such grant of License is
conditional upon payment of applicable license fees and agreement
to the License terms stated herein.

In consideration for your payment of the applicable license fees,
Sonic Studio, LLC grants you the following rights:

PRI

= CRAC ™

Select Agree to agree to the End-User Software License Agreement

Install Amarra :

Standard Install on “MiniHD”

© Intreduction
® License This will take 84.6 MB of space on your computer.

© Destination Select Click Install to perform a standard installation of
© Installation Type this software on the disk "MiniHD".

® Installation

® Summary

( Change Install Location... )

[ Go sack ) (install

Click Install.
(You will be prompted for your Mac password and the software will be installed.)
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666 & Install Amarra 2.3 Music Player

The installation was completed successfully.

@ Introduction

@ License

© Destination Select
@ Installation Type
8 Insialiation The installation was successful.

2 Summary

The software was installed.

Success!
Select the Close button to quit the Amarra installer.

* Amarra Computer Music Player is installed into the Applications folder.
It is installed here: ~/Applications/Amarra

* Amarra FLAC installs QuickTime components used for native FLAC playback.
They are installed here: ~/Library/Components/

3.1 Uninstalling Amarra Software

To remove Amarra and uninstall the software please run the “unistall amarra command”in the Extra’s Folder.
This script may prompt you for your password and will remove Amarra and all installed components.

4.0.0 Authorization Of Your Software ::

Amarra is licensed for use via a simple Internet Authorization process. Please follow the steps below to
Authorize your software. Also see Section 8 of this document for answers to questions regarding our
authorization process.

Your software is licensed for use via a simple Internet Authorization process. Please follow the steps below
to Authorize your software.

1) When you launch Amarra the first time, you will be presented with the Authorization
dialog box, Figure |, below.
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Y our Email Addr

Create Your Own Unique Pa

scuware [ sond rosowors [ by | oun

Figure | Authorization dialog box.

Evaluate button: Allows the software to run in Evaluation Mode for a specific time.
NOTE : Only your email address is required for Evaluation.
No other entry is required.
Activate button: Securely sends your Activation Code, email address and unique password to
authorize the software.
Send Password button: Sends the password you define to the email you provided.
Buy button: Takes you to an online store to purchase Amarra.
OK button: Cancels and closes the Authorization window.

2) Enter information into the provided fields..

A) Copy and Paste your Activation code into the Activation Code area.

B) Add your email address and create your own unique password in the appropriate fields.
(See Figure 2). Note: Your password should be something simple such as Amarra0Ol.

NOTE : Use the “Send Password” button if you do not know your password.

C) Click on the Activate button to activate your Amarra product.

IMPORTANT NOTE:
ﬂ Your Activation Code is delivered to you via email.  If you purchased Amarra before April 15,2011,

use your Amarra product Serial Number as your Activation Code.

Request Evaluation or Enter Code
IVINEX

sSUppC

(IR [k

evune | civate || sena passwors
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Figure 2: Sample Authorization dialog box with all fields filled out. Note simple Password.

! Your software has been authorized.
Thank You and Enjoy the Music...

Success! Your Amarra Software has been authorized.

you will be asked for a new password. The window below will appear, type in a new password and

a NOTE: Note:When you reactivate a new release of Amarra, or move Amarra to another computer
click'OK..

NOTE:To prevent Lockout use the “Send Password” button to have your password sent to you.

WARNING : After 3 attemptls with an incorrect password a lockout will occur. Write to support@sonicstudio.com
if you have a lock out and support will clear it.

Enter New Password:

ENTER HEY PAS SWDFI'[:'
1

Enter a new password to reactivate your copy of Amarra.
Authorizing Amarra After Evaluation Period Expires ::
After the Evaluation period has expired, it's easy to receive an Activation Code that enables you to continue to enjoy
the ultrafidelity sound of Amarra. Simply select the Buy button and you will be directed to an online store to purchase
Amarra.
Your Activation Code will be sent to you via email. Once you receive your Activation Code, follow the steps outlined
above to authorize your copy of Amarra.

Information About The Authorization Process ::

Activation is a set of simple and quick steps taken after your purchase of Amarra. It entitles you to use Amarra on your
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computer. If you've purchased products online or installed many of the Adobe products you have already used
a similar activation system.When your application is authorized it contacts a central server across the internet
to ‘activate’ your software and tie it to the provided activation code (which is generally provided by email).

This anti-piracy system helps protect your investment in Amarra and enables us to continue its development
at a competitive price. The license protection and monitoring system is managed by software_DNA from
soft WORKZ Innovation Inc. This system does not collect any details about you or your computer during
license activation and re-activation.

Unlike other activation systems, the software_ DNA system for Amarra does not tie your license permanently
to your computer hardware. Instead, your license is tied to your activation code and password that you define.
As a result, you will have no problem re-activating your software after reformatting your hard drive, after
upgrading hardware components in your computer, or when you move your software to a new computer.
However, activation and re-activation does require an Internet connection.This Internet connection can be on
a different computer from where your application is installed.
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5.0.0 Launching and Using Amarra

Open the Applications folder on your Mac, locate the Amarra folder.
This folder contains the Amarra application as well as documentation and an Extras folder.

Click on the arrow to the left to open the folder:

N T

|l Amarra 2.3
Le]>] aEom o (%] (8-
¥ DEVICES a Name Date Mo
== Sonic Studio ... W Amarra.app Today,
] miniHD » [ Extras Today,
& Audio [¥ Amarra 2.3 Read Me.pdf Today,
E| Amarra 2.3 User Manual. pdf Today,
B [%| Software Activiation Guide.pdf Aug 19,
i = ‘= Amarra - Support.webloc Mar 18,
@ au... @ Amarra FAQ.webloc Apr 25,
¥ PLACES
nﬁ Applications
E Desktop
(_ﬁ amarra

Amarra folder and the Amarra application.

NOTE: Launch Amarra first, not iTunes. Double clicking on the Amarra icon launches Amarra and
iTunes.

HINT: Drag and drop the Amarra application icon to your dock for easy launch.

AFmarra O
Amarra OfF
Mute Vo

Full Wals

Ciptions

Hicls

Amarra and the Finder Dock. (For more information about the Dock, see the Help menu of your Mac.)
Using the Control Key to access the Contextual Menu allows control of different commands in Amarra.
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5.1.0 Amarra Application Menus ::

5.1.1 The Amarra Menu:

o File Playlist

About Amarra
Preferences...

Services [ 3

Hide Amarra ¥H
Hide Others ™ 3H
Show All

Quit Amarra

About Amarra: Opens the modal About window. This is useful for verifying the version number of Amarra that you are
running. Click anywhere in the window to close it.

Preferences: Opens the Preference window for Amarra. See Section 6 for more information.

Services: This menu proves access to any Services that are available to Amarra.

Hide Amarra: Hides all Amarra windows. To reveal the windows, click on the Dock icon or tap the ,+tab key to cycle
through running applications to select Amarra.

Hide Others: Hides all windows other than Amarra.

Show All: Reveals all windows.

Quit Amarra: Quits Amarra.

5.1.2 The File Menu:

Amarra Iiﬂ Playlist Desk Windows Help
|

Set Amarra Source #£1 |1
Set iTunes Source $£2 [2
Set Playlist Source ¥3 |3

Convert FLAC File to AIFF... ‘
Convert FLAC Folder to AIFF... |

Authorization...
Audio MIDI Setup...
Audio /O Preferences...

Rescan 1/O...

Panner - Amarra

Preferences 3, EP
|

Extras... [ 3

Eject Disc

Quit
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Set Amarra Source [cmd+ 1] : Sets Amarra as the source for playback.
Set iTunes Source: [cmd+2]: Sets iTunes as the source for playback.

Toggling between ,Cmd-1 and ,Cmd-2 is a good way to compare Amarra and iTune
Set Playlist Source: [cd+3]:  Sets Amarra’s Playlist as the source for playback.

Convert FLAC File to AIFF..: Navigate to FLAC files and convert them to AIFF format.
The shift and ,(command) keys allow you to select more than one file.
Convert FLAC Folder to AIFF...: Navigate to a folder containing FLAC files and convert the folder’s contents to AlF
Specify the source folder and a destination folder for the AIFF files.
You can also add the files to iTunes and create a playlist as show below.

Authorization...: Opens the Amarra Authorization window. See section 4 for more information.
Audio MIDI Setup,: Opens the Audio MIDI Setup window. This is useful for configuring your DAC.
Rescan 1/O: Rescan Core Audio for current interface status.

Panner: Opens the Panner window for Amarra.

Preferences: Opens the Preference window for Amarra. See Section 6 for more information.

Eject Disc [cmd+E]: Ejects the CD from tray.
Extras...:

]
€

Cut #¥X |
HE Copy #C
¥Q Paste ®Y
—
Open Movie...
Close Movie...

Enable Debugging
System Console Log
Send Crash Report...

Cut: Cuts the currently selected string or item to the Clipboard.
Copy: Copies the currently selected string or item to the Clipboard.
Paste: Pastes the currently selected string or item from the Clipboard
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Open Movie: Open Quicktime Movie for playback (under deviopment).
Close Movie: Closes Movie.

Enable Debugging: Allows Amarra to log detailed information on its operation.
Send Crash Report: Should a application crash occur, sends important information to Sonic Studio technicians.

NOTE: Toggling between Cmd+| and Cmd+ 2 is a good way to compare the sound quality
ﬂ between Amarra and iTunes.

5.1.3 The Playlist Menu:

Amarra File 'imﬁl Desk Windows Help

Add Tracks From iTunes {3l
Add Consecutive Tracks 3l
Add Tracks From Finder... 30O

Clear Playlist
Open Playlist...
Save Playlist...
Playlist Window...

Add Tracks From iTunes: [sft+cmd+i] Adds tracks selected in iTunes into an Amarra Playlist.

Add Consecutive Tracks [opt+cmd+i]: Adds consecutive tracks from iTunes. A specified number of tracks are loaded.
See the Amarra Preferences section 6.3. After the tracks in the Playlist are played, more get loaded automatically.
Add Tracks From Finder... [cnd+o]: Select and add audio tracks from the Mac Finder.

Clear Playlist: Clears the content of an Amarra Playlist.
Open Playlist: Opens a saved Playlist.
Save Playlist: Saves open playlist for later recall.
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5.1.4 The Desk Menu:

Amarra File Playlist I:E' Windows Help

Open Sonic EQ Setup...
Save Sonic EQ 5etup...
Save As Default

Toggle Mute THEM

Open Sonic EQ Setup... A Finder window opens and allows you to navigate to a previously-saved Sonic EQ Setup.
Save Sonic EQ Setup: A Finder window opens and allows you to save and name the current (open) Sonic EQ Setup
for future recall.

Save As Default: Save the current (open) Sonic EQ Setup as the Default EQ. Each time you launch, this Sonic EQ
Setup will be recalled and enabled.

Toggle Mute [opt+cmd+M] :Turns Mute on and off, cutting the volume to 0, then returning the volume to the previous
level.

5.1.5 The Windows Menu:

Amarra A
iTunes ol
Playlist P
Equalizer

Background Manager

Amarra [optt+a]: Opens the main Amarra window.

iTunes [opt+i]: Opens the main iTunes window.

Playlist: [opt+p]: Opens the Amarra Playlist window. Must enable Playlist mode.
Equalizer [opt+E] : Opens the Amarra EQ window.

Background Manager [opt+B]: Opens the Background Manager window.

5.1.6 The Help Menu:

MINI File Desk Windows

Playlist

MINI Help

Amarra Help: Opens the Amarra Help document.
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6.0.0 Using Amarra and iTunes

Amarra runs alongside Apple’s iTunes program.This allows you to manage and access all your music through
the main iTunes Music Library or through custom iTunes Playlists.

, Amarra occupies the area to the left of your iTunes window:

i e Wy - Ui e
Grwmmdd Praed - Worty b Bl &
1 il — X ]

ED anem  Gisrws  Compaian

HLH s, FN dewn, i48 CF

Amarra and iTunes.

You can use iTunes like you always have, select the songs / Playlists and play. Amarra will play all your songs and
seamlessly switches to iTunes for playing back protected files such as songs purchased from the iTunes store.

Amarra plays most compressed files including FLAC, MP3, AAC, and Apple Lossless (ALAC).

ﬂ NOTE: Amarra does not play variable bit rate or low bite rate MP# files.

Using the Playlist button Amarra allows you to load the selected tracks from iTunes into Amarra as a Playlist.
With the Playlist loaded iTunes is Not Used and is now stopped. This is indicated by the Playlist button turning
Green and now showing the Tracks that are loaded as a menu.

See Section 6.6 for more information on using the Playlist.

NOTE: This feature will play the loaded tracks without any gaps.

NOTE: Amarra will load tracks and disable iTunes so the tracks can then be played in
ﬂ Amarra. This can provide optimal sound reproduction.
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6.1.0 Using Amarra:

e
irni nsky-Saies MkE; Moo Ecpanamaol On

e e e ]

© @ 0O, ® ©® 06 ®

I. TRANSPORT 4. TRACK INFORMATION /- AMARRA EQ

The Previous Track, Play/Pause, The upper display shows name This opens (or clloses)l the Amarra
and Next Track buttons. are and artist for the track. EQ window. Option click to enable/
located here. disable EQ. The presets are shown

Gain is displayed in Red if not O above.

along with the dither status.
2.Amarra VOLUME 8.CONTROLS
This slider controls the output At the bottom the memory i
volume. being used for CACHE playback. Playback Options
The buttons are hot spots for O, Sample Rate, current time, and - Stop at end
and -144 dB. EQ Settings are displayed - Repeat Playlist
The Up and Down Arrow keys on - Load next set of tracks
your keyboard can be used to i Plavlict M
control the volume. 5. AMARRA / iTUNES aylist enul
L , - Add Tracks from iTunes
This indicates Amarra's Add Tracks f Find
NOTE: iTunes and Amarra Volume playback status: ) Cont raICPI TO? inaer
are kept in sync. Blue = Amarra is playing o Fayis
' Grey = iTunes is playing Link Remote
NOTE:You may notice a small Orange = iTunes is playing _ allows iTunes / Remote
de|a)/ aﬂd a Sma” dOUb“ng Of ° Sample ra‘te not Supported -to COﬂtI‘O| P|ay|ISt
sound when using the iTunes « a protected file . ‘
Volume is being moved. Link Windows:
- keeps iTunes and Amarra
NOTE:Volume will be hidden if 5. PLAYLIST window in synchronization
window is too small. This button sets the 9. ARTWORK
Playlist as the source. This displays the artwork for
3. CACHE PLAYBACK aTrack (if it is available). Use the
CACHE Loading for playback. small “x"'to hide the artwork.
6. TRACKS
When enabled songs are first This displays the list of tracks Iof METERS / D,EVICE INFO
pre-loaded  into  RAM  to loaded in the current Playlist. This W'U Show/H|c!e the meters
Amarramize disc access. This can and device mfﬁrrﬁ;ﬁtmn.
be used in Amarra or Playlist Use the LEFT "x" for Meters.
Modes. Use the RIGHT “x" for Meters.

seconds area of the Time Display section and use the down arrow to back up | second per key

TIP: Want to hear that wonderful instrumental section again? Stop Amarra, double-click in the
a stroke. Hit the spacebar to start play at the new time selection.

TIP: Holding the Mouse (without clicking) over any button will display a Help Tip displaying what
a the button does.
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6.1. 1 Amarra Meters And Device Info Display

This section presents how to show the Meters and Device Information. On the Display Area in the lower
left are two X" buttons. These can be used to toggle the display of Meters or the Current Audio Device..

ﬂ TIP: Use the LEFTMOST “X” in the lower left corner to show or hide the meters.

TIP: Use the RIGHTMOST “X" in the lower left corner to show or hide device information.

44100 00:00:39:28

Amarra Track Area with Meters displayed

6.2.0 Amarra EQ
This section presents an overview of the Amarra EQ. Use this to alter the sonic characteristics of the sound.

Amarra EQ employs a Amarramal phase topology and double precision operations to ensure inaudible results
while preserving the fidelity of the most delicate acoustic performances.

The EQ window is opened by clicking on the EQ button at the top of the Amarra window.
Use Option-Click on the EQ button to mute the EQ.

The EQ can also be set using the EQ presets as set in the Track Information from iTunes.
Select a Track in iTunes and using “Get Info” select the “Options’ Tab and set the EQ Preset.

Equalizer Preset: I' Classical |+i
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Amarra EQ:

Use the Amarra EQ window to alter the sonic characteristics of the sound. Amarra EQ employs a Amarramal
phase topology and double precision operations to ensure inaudible results while preserving the fidelity of the
most delicate acoustic performances.

PRESETS
EQ (On/Off)

This turns on Amarra EQ, or when
unlit indicates the EQ is not being
used.

PARAMETRIC |

21475.00 _u/ M

PARAMETRIC 2

740.00 ﬂ/ L/

PARAMETRIC 3

Amarra comes with a set of EQ settings that are modelled on the iTunes presets. In addition there are 3 Room
Node settings for common bass adjustment processing.
NOTE:The Desk menu items allows you to save and recall your EQ settings. Set up an EQ, go to the

y-’// Desk menu and select Save Sonic EQ Set Up.

7’/‘/ NOTE: If the “Link iTunes EQ" preferences is check then Amarra will use the EQ Preset defined in
iTunes to set the EQ for a Track.

Parametric EQ :

The parametric filter has parameters for Resonant Frequency, Gain and Quality Factor. The Quality Factor, or

Q, is defined as the resonant frequency, or center frequency in the case of a symmetrical filter; divided by the

bandwidth.The filter is a Ist Order filter.
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Amarra provides three parametric filters to tailor your sound:. All processing is done using 64bit floating point
arithmetic. The parametric filters are classic, three parameter versions, with Resonant Frequency, gain, and
Q. Q or Quality Factor is defined as the resonant frequency, or center frequency in the case of a symmetrical
filter; divided by the bandwidth. The bandwidth is, in turn, defined as the one or two frequencies at which the
filter response is 3 dB up or down from unity gain.

The Amarra EQ Window also has a set of presets based on common Room Nodes for correcting simple
room acoustics. Additional presets are based on an analysis of iTunes EQ Presets. Amarra uses the Sonic EQ

to process the audio and provide the selected effect.. The following presets are provided:

Default User Setting
Acoustic

Bass Booster

Bass Reducer
Classical

Default

Acoustic

Bass Boost

+ Bass Reduce
Classical
Jazz

Pop

R&B

Rock
Flat

Room Node - 30Hz
Room Node - 40Hz
Room Node - 50Hz
SACD Filter

|

400.00 I =TT

Jazz Room Node = 30 Hz
Pop Room Node = 40 Hz
R&B Room Node = 50 Hz
Rock SACD Filter

Flat

Expressing the width of a filter as a Quality Factor, rather
than bandwidth, provides a more intuitive sense of the
filter's subjective “sound,” since the same value of Q will
produce different bandwidths at different frequencies. The
higher the frequency, the wider the bandwidth will be for a
given Q value, which roughly corresponds to our auditory
mechanism’s ability to perceive a filter's action.

As an example, a parametric filter with a Q of | has a
bandwidth of 100 Hz when its center frequency is set
to 100 Hz but, it has a bandwidth of 1000 Hz when the

center frequency is set to 1000 Hz.

Curves for Parametric EQ

The family of curves shown below include a wide Q of 0.5,
a medium Q of 2.0 and a narrow Q of |0.The order or
slope of this filter is 6 dB per octave.

Figure 10.2 1sf ardar paramatric with £, of 1000 Hz
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6.5.0 Amarra Background Manager:
Amarra is equipped with the Background Manager whose function is to process sample rate conversion as a background
process. The Background Manage window largely consists of 2 areas, the “Soundfiles” area and the “Processes” area, topped

by the Target Folder field.

To open the Background Manger, select the Windows > Background Manager command.

iZotope

¥ olumesd 250 JimmpUsersljamessan/Deskl opla4 1 il esd 3§, 2 Flower w206 b-8 K. ail

The Background Manager window.

The Background Manager utility allows:

I) The drag and drop of audio files into the Soundfiles section.
When a sound file is selected in the list, the black status bar below the list displays the sample rate, word
length and number of channels of the selected file. Multiple sound files can be added to the list by repeating
this action.
To remove sound files from the list, click to select the list entry and delete it by hitting the backspace or delete
key.To clear the list of all sound files, click the Clear All button to the right of the Soundfiles list.

2) The definition of a target folder for the processed file.
In the Target Folder field, the target folder for newly created sound files is specified. To select a target folder,
click on the Set Folder button. A standard Mac OS browser opens, allowing you to navigate, create and/or
choose the desired destination folder. Option—clicking on the Choose button forces Amarra to use the input
file's folder also as the target folder.
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3) The definition of a target sample rate.
The Sample Rate Conversion background process has thirteen choices of target sample rate. As with any
SRC process, if the target sample rate matches the clock rate of the playback system, then the process is
considered a sample rate conversion. If, however, the target sample rate does not match the clock rate of the
playback system, then the process is considered a varispeed. In either case, the actual processed data in the file
is identical, only the sample rate flag is different. SRC preserves pitch and duration, while varispeed produces
modified pitch and duration from the original.

The Target Sample Rate menu includes the following choices;:

r

8000 hz
44056 hz
44100 hz
47952 hz
48000 hz
88112 hz
BB200 hz
85904 hz
¥ 86000 hz
176400 hz
192000 hz
352800 hz
384000 hz

Once the processes are being executed, all sound files and processes remain in their respective lists.

To abort the current process, click the Abort button and the current process will be aborted, initiating the next
process in the Queue.

4) A"*Processing” section to monitor the processes progress.
Processes can be started by hitting the “Execute’ button.
Processes can be Aborted by hitting the “Abort” button.

5) The Background Manager also supports conversion from DSD to PCM file of any sample rate. Currently the DSD
converter supports original “.dsd’,, and “.dff" files.
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6.3.0 Amarra Preferences

This section presents an overview of the Amarra Preferences.

LAUNCH SETTINGS
LAUNCH / QUIT ITUNES:: Forces iTunes to launch 00D Preferences
or quit in sync with Amarra.

HIDE ON LAUNCH :: Forces Amarra to hide its
windows after startup.

LINK ITUNES WINDOWV :: Forces iTunes to remain
‘attached’ to Amarra's main window, regardless of the main
window's location.

LINK ITUNES EQ PRESETS :: Forces Amarra to follow
the EQ settings in iTunes.

PLAYLIST FOLLOWS ITUNES : Forces Amarra’s
Playlist to follow the track selections in iTunes

PLAYBACK SETTINGS:
BYPASS COMPRESSED FILES :: Forces Amarra to
skip over lossy encoded music files like MP3 and AAC.

Useful for PPC Macs.
TRACKS TO LOAD :: Sets the number of consecutive
tracks that Amarra pulls from iTunes when auto-populating a
Playlist.
MEMORY AMOUNT :: Set the amount of Random
Access Memory that Amarra uses to temporarily store audio
in Cache Mode.

DITHER SETTINGS
AUTO-DITHER :: Automatically enables redithering when
Amarra’s gain is not set to unity or 0.
TYPE ::

TPDF: Sets Amarra’s redithering function to Sonic
Studio’s proprietary Shaped TPDF (Triangular Probability
Density Function) dither type.

MBIT+: Sets Amarra’s redithering function to
iZotope's proprietary MBIT+ dither type.

Shape: When Type is MBIT+, sets the amount of
spectral shaping, from none to extreme.

Wordlength: Sets the number of bits for Amarra’s
output. This setting should match your DAC's word length
specification. If set to less than 24 bits, Auto-dither should be

enabled for best quality. SONIC HARDWARE SETTINGS ::

Requires Sonic Studio Hardware.
PROCESSING SETTINGS Launch/Quit Console: Forces Sonic Console to launch
FULL SONIC-EQ :: Changes the Equalizer from iTunes- or quit in sync with Amarra.
style generic curves to fully adjustable, Amarramal phase Sonic Dim Front Panel: Dims the front panel display.
EQ. Not available in Amarra or Junior: Control Volume: Interlocks Amarra’s gain control with
Pure Gain :: Forces Amarra to change gain in | bit steps for the hardware gain control so either can be used.
less gain interpolation and higher quality. Gain Adjustment: Set the system gain to match
HardLimit:: ChangesthewayAmarrareproducesconsecutive professional (O dB) or consumer electronic (-10 or -14 dB)
oversamplesRecommendedformusicwithlimiteddynamicrange. standard levels.
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If dither is enabled then the output of Amarra will be dithered to the setting of the Output Wordlength
specified. This can be useful for providing the a better sound when Gain is used or if your DAC only supports
a limited word length (16 or 20 bits).

NOTE: When the Output Wordlength is set to 24 bits the dither will be "“disabled” if the Gain
ﬂ has not been modified (at full volume). Once the Gain is adjusted then dither is re-enabled.

Amarra provides two dither options: Sonic TPDF and Izoptope’'s mBIT+ Dither. The mBIT+ is an advanced
psychoacoustic dither and supports different shapes: Light, Medium, High, Ultra,

6.4.0 Using Amarra with Remote Control

6.4.1 Remote Control Volume

You can use your iTouch / iPhone iTunes Remote to control the Volume in Amarra. When you adjust the

volume using your Remote (or using iTunes) Amarra will follow.

NOTE: You may notice a small doubling of sound while using the remote volume control. This
will stop once you stop moving the volume (iTunes will mute).

6.4.2 Using Amarra with Infrared Remote Control

The Amarra Remote Application is used to support the Apple Infrared Remote. The Amarra Remote
Application can be found in your Extras Folder and is only required for the infrared.

We can also recommended the “rowmote” iPhone/iTouch Application available via the iApp Store.
For more information please visit http://www.rowmote.com/Rowmote/Rowmote.html

6.4.3 Using Amarra with Remote Control And Playlists
You can use the Apple Remote to control the Playlist. Use the “Link Remote” Preference to enable this

feature. When Enabled you can choose tracks in iTunes (or Apple Remote) and the Playlist will automatically
follow. Likewise, selecting a song in an Amarra Playlist will select the iTunes track.

NOTE: If you Add files from the Finder than this feature will Not Be Used.

NOTE: This may cause dropouts and skips with large iTunes libraries.
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6.5.0 Using your Airport Express

Using the “Airfoil” application from Roque Amoeba allows you to route the output of Amarra to an Airport Express. For more
information visit http://www.rogueamoeba.com/airfoil/mac/ for more information.

["] Computer

Available
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6.6.0 Amarra Playlist Mode

Amarra provides its own Playlist window that can be used to control playback of soundfiles instead of iTunes
When Tracks are loaded into a playlist there are accessible from the “Tracks” Popup in the main Amarra
Window. When the “Playlist” button is selected then the Playlist Window may also be visble .

Uﬂ :ﬂﬂ :ﬂﬂ :ﬂﬂ Aoastic

Stop That Train
Stir It Up

Stiff Necked Fools
Steve McQueen
Stella Blue >

Stay In Touch
Statesboro Blues
Stand Back

Co =1 @ GEEL RO

Playlist Tracks In Amarra Window

The playlist is also used for playback of gapless material (reads the iTunes Gapless tag). Tracks can be loaded
via a selection iTunes (from the Library, from an iTunes Playlist or from a CD) or using the Finder. You can also
Drag and Drop files from the finder or from iTunes itself onto Amarra to add them.

Amarra Playlist
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/ NOTE: Use Playlist mode for playback of gapless recordings. Make sure the Gapless
7 option is enabled for each song of a gapless recording.

[Info  Video  Serting - Options-|

[ volume Adjustment: =~ -~ -~ %

=100% Hone +100%
[ Equalizer Preset: | None )
1 Media Kind: | Music s

[ Part of a compilation: | Yes E
[ Remember position: | No E
"] Skip when shuffling: | No @

Eﬂapless album:

e

Erable Gapless Opticn iniTunes

( Cancel ) (0K

iTunes song Get Info dialog box, Options tab.

Playlist Navigation =
Left Arrow = skip to next track and play it
Right Arrow = skip to previous track and play it
Down or Up Arrow = move to another track without stopping playback of current track. Hitting the
Return key or spacebar 2 times stops the current track’s playback and starts playback of the newly
selected song.

LINK BUTTON
- - This button will link the Playlist window to the Amarra Window.

PLAYBACK OPTIONS

Using the Playback Options button on the Amarra window you can choose to stop the playlist, repeat or load
the next set of consecutive tracks in to the Playlist.
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. - Do Not Repeat Playlist and stop at end.

‘ - Repeat Playlist from top.

."‘“" - Load the next set of Tracks when this playlist is finished.

ADD ITUNES / LOAD ITUNES/ ADD FINDER
Files can be added from iTunes or from the Finder using these commands. The Add Finder command will prompt you to
selected files to load. You can select multiple files and folders.

USING APPLE REMOTE VOLUME
You can use your remote to control the Volume using your Apple Remote or Rowmote Application.

USING LINK REMOTE PREFERENCE

With the “Link Remote” preference enabled Amarra will automatically load Tracks into the Playlist based on the selection in
iTunes (which can be controlled using Apple Remote).

ﬂ NOTE: If any files are added from the Finder then this preference is not enabled.

DRAGGING FILES AND FOLDERS

Files can be added from iTunes or from the Finder by dragging the Files or Folders from the Finder to the Playlist Window. You
can also drag Tracks from iTunes.

NOTE: Inserting a CD into your Mac's drive can yield stunning results when played back through a
ﬂ Playlist. Select the CD in the left margin of iTunes, then press the ADD ITUNES button in Amarra.
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6.7.0 The Panner Window

Amarra comes with a stereo (and multichannel) panner that can be used to route the
output with variable gain. To open the panner select File > Panner, which brings up
the Panner window.

™ ™ 7 Panner - Amarra

Track @-EE3 Type TEEEDTTERS

Stereo Panner

Figure 6.12: The Panner in Stereo mode

By default, the panner opens in stereo mode. In the upper left corner, the channel to

which the panner currently applies is indicated. As this Track indicator is also a drop
down menu, it operates as a Strip selector for the panner as well. In the upper right
corner, theType indicator/menu is visible and offers three options:

1. Off — In this state, the panner is turned off and the selected Strip is
restored to the state it was in before the Strip was routed through the
panner.

2. Stereo— In this state, if either Strip 1 or 2 is set to stereo, the other desk
Strip is bus paired to it as a stereo panner.

3.  MultiChannel—Inthis state,, the panner unfolds to show a circular joystick
panner with multichannel buses, each bus indicated by a loudspeaker
symbol. Note that the multichannel plus LFE choices in this menu are not
operational. This is not supported in the current version of Amarra.

To change the panner state, click-hold on the red dot and drag it towards effect
the desired output. The output level fields, located next to each loudspeaker symbol,
indicates the panner output level in dB and are updated continuously during panner
movement. Alternatively, simply click on the location in the Panner circle where you
want to place the panner, and the panner moves to it instantly. Additionally, clicking
on one of the loudspeaker symbols moves the panner to that position instantly.
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6.8.0 Audio I/O Preferences

By default, Amarra uses the first two available inputs of the interface currently configured as
input in Audio MIDI Setup. However, Amarra can be configured to playback to any valid output
by means of the File > Audio I/O Preferences window.

"6 a6 Audio 10 Preferences

He-Scan O Adidsd MIDI Seiup...

Master Clock

Fresquencyt SB000.00 Hz LK Device: ; Board 1; Address 1

- D
Set 1-2

E_&Iilt—l_l Audio

Figure 5.1: The Audio I/O Preferences window
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Master Clock

Freguency: 44100.0 Hz @ Lock Device: Model 304; Board 1; Address 1

Internal

Set Analog Set Digital

iy CTERIINRE s ic St
series 300 Hi-8

b Fw 2
b FW &

Figure 5.1a: The Audio I/O Preferences window with Sonic Studio Series 300 hardware attached.

The bottom half of this window shows the currently active audio interface as selected in Audio
MIDI Setup.

Note that virtualized or “aggregated” devices, as defined in OS version 10.4
E I and higher, appear as one Core Audio interface.

Uses an aggregate device when the device does not have input and output.

In the area of the audio interface icon, the line inputs L1 to Ln are shown, together with a drop
down menu selector. When one of the line input selectors are clicked, a list of all available in-
puts for that selected audio interface are shown. Selecting any available input from the audio
interface re-maps that input to soundBlade’s inputs used for recording external sources. It also

relabels the output bus assigns on the Desk.
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None
v FW1
Fw 2
FW 3
FW 4
FW 5
FW 6
FW 7
FW 8
FW 9
FW 10
FW 11
FW 12
FW 13
FW 14
Inl FW 15
In 2 FW 16

Figure 5.2: Input selectors

Amarra’s clock source should be checked as well.To do so, select either “internal” or “external”
from the Master Clock source selectors.
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+  Internal

WC (44.1/548)

WC (38.2/96)

WC (176/182)
WCx256 (44.1/48)
WCxZ56 (BB.2/36)
WCxd56 [(1785102)
AEE T (1x)

AES 1 (2x)

AES 1 (4x)

AEE 2 (Tx)

AES 2 (2x])

AES 2 (4x)

AEE 3 (1x)

AES 3 (2x)

AES 3 (4x)

AES 4 (1x)

AES & [2x]

Clock source selection

In addition, due to Mac OS restrictions, the sample rate must be set to match the incoming clock
source, even when an external clock source is selected.

v Internal 44100.0 Hz
Internal 48000.0 Hz
Internal 88200.0 Hz
Internal 96000.0 Hz
Internal 176400.0 Hz
Internal 192000.0 Hz

Sample rate selection

The settings in the Audio 1/O Preferences window reflect the settings in Audio MIDI Setup at
the instant you open the Audio I/O Preferences window. However, the information in Audio I/O
Preferences are not dynamically updated if anything in Audio MIDI Setup are changed while
the Audio I/O Preferences window is open.To make sure that the Audio I/O Preferences window
accurately reflects the current setting of Audio MIDI Setup, press the “Re-Scan I/0” button. This
updates the Audio I/O Preferences and re-loads the current settings from Audio MIDI Setup. To
open Audio MIDI Setup from within soundBlade, click the “Audio MIDI Setup...” button in the
Audio I/O Preferences window.
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7.0.0 Registering Your Amarra Software

In order to receive warranty service, you must register your product with Sonic Studio. This may be done at
any time with proof-of-purchase. We strongly recommend that you register with Sonic Studio as soon as you
purchase your unit. This will ensure the best possible support for your purchase.

| Your product will be registered with us.
Registration is used as proof of ownership if your product is ever lost or stolen.

2. Sonic Studio updates Amarra software on a regular basis.
This allows us to keep you informed of updates as they become available.

Please register your Amarra software using our automated registration VWeb page at:
http://www.amarraaudio.com and click on Support => Register

Alternatively, our mail address is:
Amarra Software Registration
Sonic Studio, LLC
330 Sir Frances Drake Blvd
Suite A
San Anselmo, CA USA
94960-2552
Fax [-775-330-8923

If you encounter issues using Amarra please refer to the information below for assistance. If none of these steps
address your problem please contact your dealer or Sonic Studio support for more help.
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8.0.0 Troubleshooting Guide

Basic Macintosh Setup Tips
iTunes:
* Disable the Crossfade Songs preference in iTunes
* Disable the Sound Enhancer preference in iTunes
* Disable the Sound Check preference in iTunes

Energy Preferences
* Disable Sleep and other Energy saving Preferences.
Bluetooth
¢ Disable Bluetooth
Spotlight
* Disable Spotlight
Security
* Disable Infrared
TimeMachine
¢ Disable TimeMachine on your media drives.

* We highly recommend a fresh install of the operating on a clean disc.
This can prevent problems later on.

* We also recommend that your computer be used exclusively for music playback.
Email, web browsers, screen sharing and other applications can effect performance.

Issue: Amarra Authorization Answers.

I have entered my code and password correctly with a new password to do a re-activation,
why is the application not being re-activated?

Verify that you have an Internet Connection. Your new password must be a new and never-used
password.Verify that you have not previously used this password with this activation code.

How often will my application connect to the activation server via the Internet?

Your application uses the Internet when it is first installed, when it is re-activated (such as after a disk
reformat and reinstall, or if the software is moved to a new computer). The application may also do a
quick check with the server when you run the application.

software_DNA includes an anti-fraud system that disables activation codes in cases of credit-card
chargeback or refund. Unless you are using offline activation (see below), your application will need
to connect to the Internet at least once a month to verify the license status.VWhen an activation code
is revoked, the software remains in trial mode until a new, valid activation code is provided.

Will my application work if | don’t have an Internet connection?

Yes, there is an offline activation method available. If no Internet connection is found during activation,
orthe activation server is not reachable, the software will ask you to do offline activation.The software
will provide step- by-step instructions, where a file is written to disk that you move to a computer
that does have Internet access (or email access).You can move this file via LAN, floppy disk, CD-R
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or USB key.You can use your Internet browser (on a machine that does have Internet access) to visit
a special page to upload this file and receive another file in return. If you do not have any working
browsers then the file can be emailed to our tech support (note there may be a delay in the return
of the file depending on the time of day and week).

During activation what information is passed to the server?

No personal information or information about your computer configuration are transferred. There is
a one-way hash* of some machine configuration data, your chosen password, and the optional email
address sent to the server.Your application may have an optional registration page and if you choose
to fill that out, that information is also transferred during the first activation. If you do not provide
the optional information (email address and registration information) then no personal information
will be transferred. VWe suggest you do not use one of your important personal passwords for the
activation password, or a password that personally identifies you.

*One-way Hash: Codes that identify parts of the computer are put through a special function (called
a ‘one way hash’) that turns the codes into one code number that is unique to your computer but
cannot be deciphered (or reverse engineered) to determine what those components are. Only this
hash value is sent to the activation server and not the details on the computer parts.

Can | move Amarra to another computer?

Yes, this can be done easily. It is simply a matter of deactivating the application on one computer,
reinstalling the application on the new machine, and reactivating the software. If you have remembered
your password this will be a fast and easy process.

What is the email address for and is it mandatory?

The email address on the activation and reactivation dialogs is mandatory. It can be used to retrieve
a lost password. When you provide the email address it will not be used for marketing purposes or
sold / provided to any third party. If you do provide an email address we recommend it be one that
will be active for some time.

What if | have forgotten my password and did not provide an email address (or my email
address is no longer valid)?

During a reactivation the previously provided password is required. If the password has been lost and
cannot be recovered (because an email address was not provided, or the email address is no longer
valid) you will need to contact our support via email or by phone.We will be happy to reset your
password.

Will changes to my computer cause my application to stop working?
There are no changes that will cause a permanent disabling of the software. Major changes (disk

reformat being one such major change) will mean that you need to reactivate the software. If you
have your password this will be a fast and easy process.
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What happens if Sonic Studio or soft WORKZ suspends service or goes out of business?

Both companies have been in business for several years, and are healthy and stable and will be around
for many years to comel!

Regardless, your activated application will continue working without the Activation server, although
new activations or re-activations will not be possible. Both companies are committed to ensure that
a patch will be made available ASAP to resolve this. Either a version with a replaced activation system
or a version with no activation will be provided.

I wish to do an online activation but my firewall is set up to block such requests.What are
the firewall settings?

The following is the information that you need to setup your firewall:
Main server IP address: reg|.softworkz.com
Backup server IP: reg2.softworkz.com
Backup server IP: reg3.softworkz.com
Port: 80 (Standard HTTP)
Domain: softworkz.com

Why is an activation system required at this time?

Issue:

Issue:

Software companies around the world have come to realize that activation- type copy-protection
systems provide a reasonable solution to the problem of piracy while at the same time respecting
customers by not burdening them with a hard-to-use licensing system. Reducing piracy means that
the software vendor can use steady revenues to further improve the product and guarantee business
continuation. It is unfortunate that piracy exists because we know the majority of our customers
follow the license terms but it is a fact of life in this digital age.We trust that this new system will be
virtually transparent for the majority of customers.

How to set up a remote volume

Amarra does not support streaming of remote songs.
Amarra requires that all volumes be mounted on the computer as a shared volume.

Solution:
* Mount the remote volume with Read/Write Access on your local Macintosh
- Use the Network (Cmd-K) to locate and mount the remote volume
* In iTunes used the Add to Library command to add the songs from the Mounted Volume
* Mount the remote volume with Read/Write Access on your local Macintosh

Audio Clicking or Ticking Sound.

Solution:
* Disable Spotlight (add volumes to the Spotlight Privacy Preference)

I) Open System Preferences and locate the Spotlight Preference
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Systemn Preferences

a N
== <
Exposé & International Security Spotlight

Spaces

2) Select the Privacy Tab and add all your media drives

Spotlight
4| - Shiow All 'q,

Spotlight helps you guickly find things an your computer. Spotlight is located
at the top right cornar of the screen.

[ %earch Results  Privacy |

Prevent Spatlight from searching these locations:

Chick the Add bafbon, or drag a folder or diik Inbo the 138 below,
3 audia

2 DataStore

3 zeon
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Solution:
* Disable Network Shared Access.

I) Open System Preferences and locate the Sharing Preference
2) Disable Web Sharing, Remote Login and Remote Management.
Please note for support the Remote Management preference may be required.

e

Sharing
4| e Show Al

Computer Name:  developrment
Computers on your local retaork can

developenant, local

On | Service & File Sharing: On
[ DVD or CD Sharing DUher users Can Boess sh
M Zereen Sharing all wolwmes, an afp:/ /092,
W File Sharing
[ Printer Sharing Shared Falders:
[ Web Sharing
[ Remote Login
[ Remote Management

! Remote Apple Events A
=

Xgrid Sharing
Internet Sharing

Solution:
* Disconnect multiple FireWire devices and reduce daisy-chained connections.

Solution:
* Shut down other applications such as email and browsers.

Solution:
* Increase the amount of RAM in your computer.

Solution:
e Check that all drives are HFS formatted.
Amarra does not support FAT32 drives.

Solution:
* Change the Sample Rate manually using Audio Midi Setup to a different value.
Then switch the Sample Rate back.
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Issue: Songs do not change or sound correctly.

Solution:

* Disable the Crossfade Songs preference in iTunes
* Disable the Sound Enhancer preference in iTunes
* Disable the Sound Check preference in iTunes

* Disable Sleep and other Energy Preferences.

Issue: Amarra does not play audio.

Solution:
* Check Permissions - Are they Read / Write
* You may also Quit Amarra and iTunes and restart Amarra.

NOTE: Sound files with names that contain """ or other
Foreign characters may not play properly.
Changing the name of the soundfile can fix this.

Issue: Amarra does not play audio.

Amarra requires an input clock under Audio Midi Setup.
If your devices does not have an input when shown under AMS then please
follow the instructions for creating an Aggregate Device.

Solution:
* Create an Aggregate Device under Audio Amarra Setup.
Please refer to the Aggregate Device Setup in the Documentation Folder.

Issue: Sample Rate Does Not Change With Soundfile.
Does your device support the sample rates for your music?

Amarra will only use the available rates on the device.
Otherwise, iTunes will be used (and sample rate conversion will occur).
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9.0.0 Support

We are committed to your successful use of Amarra and offer support for Amarra through your local dealer
or via phone and email through Sonic Studio. Please also ask your local dealer for assistance. They have a

great deal of knowledge about Amarra and are an excellent resource.

For email support, send email to:

support@sonicstudio.com

You can always find the latest information and updates for Amarra at our website:

www.amarraaudio.com

©2007-201 I Sonic Studio, LLC — Al rights reserved. No part of this document may be reproduced, stored in a retrieval system or
transmitted in any form or by any means, without the prior written permission of the publisher

Sonic Studio, Amarra, Amarra, Amarra Junior, SSE, NoNOISE native, Sonic EQ, Model 302, Model 303, Model Four, Model 305 and the

Sonic Studio and Amarra logos are trademarks of Sonic Studio, LLC. All other company or product names are either trademarks or

registered trademarks of their respective owners.
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